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Chapter 1: Introduction to FaxCenter
CHAPTER 1: INTRODUCTION TO 
FAXCENTER
This chapter includes the following sections:

• Introducing FaxCenter

• Understanding FaxCenter permissions and routing rules

• Getting Started with FaxCenter

• About fax expiration

Introducing FaxCenter
FaxCenter is a fax routing application that works together with the fax server in your organization. You can think of 
FaxCenter as a “mail distribution” center for your faxes. As soon as your organization receives a fax from another 
organization, the fax appears in your FaxCenter account, and you must determine the most appropriate recipients 
and locations for the fax. These recipients and locations might include e-mail recipients, ax machines, printers, and 
Document Management Systems.

After the fax arrives in your FaxCenter account, you should review the fax, annotate it if necessary, and then route 
it to the most appropriate recipients and locations. While working in FaxCenter, you can generate, print, and save 
reports on faxes, as well as set up automated routing so that all faxes go to a particular recipient or location.

Using FaxCenter you can:

• Route inbound faxes to e-mail recipients, fax machines, printers, and Document Management
Systems in your organization’s network.

• Release outbound faxes to secure destinations.

Some unique FaxCenter features enable you to:

• Edit and annotate faxes before you route them.

• Route and re-route partial, single, and multiple faxes.

• Route faxes to a Document Management System.

• Reassign inbound faxes to other FaxCenter users.

• View the history of a fax.

• Generate reports on all faxes or only the selected faxes in a list.

• Configure audible and visual notification alarms for new faxes.

• Search all the faxes in FaxCenter by their properties.

• Route new faxes automatically to a specified destination.

• Enable After Hours so that inbound faxes are processed differently when all FaxCenter users in
your organization are unavailable to process them.
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Understanding FaxCenter permissions and routing 
rules
Your network administrator configures routing rules that determine which faxes appear in your FaxCenter account. 
The features you can use to route them are determined by the permissions your network administrator assigns to 
you.

Routing rules
Routing rules are rules your network administrator defines on the Omtool server. These rules determine which faxes 
appear in your FaxCenter account. Two examples of routing rules are:

• Routing rule that routes all incoming faxes to specified Administrative Assistants. The
Administrative Assistants then annotate the fax if necessary, and routes it to the appropriate
recipient in your organization.

• Routing rule that routes all incoming faxes directly to the intended recipient. If a fax is undeliverable
for any reason. the fax is routed to a network printer.

Figure 1-1. Example of routing rules

Above: Based on the routing rules in place faxes will arrive at their destination either automatically or 
forwarded by an Administrative Assistant.
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Permissions
As a FaxCenter user, your network administrative has assigned you permissions to use FaxCenter features. 
Depending on your role in your organization, you might have permission to use some FaxCenter features but not 
others, or you might have permissions to use all FaxCenter features.

Only your network administrator can modify your FaxCenter permissions. These permissions affect the following:

• Password - Your network administrator can set and reset your FaxCenter password. Your 
password allows you to log into FaxCenter.

• Fax locking - If other users in your organization can view the same faxes you can, a network 
administrator might set a fax lock timer. This ensures that no one else can view, edit, or route a fax 
while you are working with it. The fax locking feature has a timer, however, and when the fax lock 
expires, the fax becomes available to other users so that they can view, edit, or route the fax. (Note 
that if a fax is locked, a lock icon appears next to the fax in the list.)

• Deleting faxes - You might or might not have permission to delete faxes in FaxCenter.

• Moving faxes - You might or might not have permission to move faxes to the Processed Items list.

• Combining faxes - You might or might not have permission to route multiple faxes as a single fax.

• Viewing entire faxes - You might or might not have permission to view an entire fax in 
FaxCenter. Note that if you do not have this permission, you will be able to view only the first page 
of the fax.

• Providing information about the original fax sender - You might be required to enter 
information about he original sender of a fax when you route it if this option is enabled in your user 
account.

After you route a fax, the recipient receives an e-mail message. This message might contain 
information about the original sender of the fax. (Note that your network administrator can change 
the content of the e-mail message that notifies your routing recipient.)

• Activating After Hours - You might or might not have permission to turn After Hours on and 
off.

• Releasing outbound faxes to secure destinations - You might or might not have permission to 
release outbound faxes to secure destinations.

• Viewing the faxes available to all FaxCenter users - You might or might not have permission 
to view the faxes of all FaxCenter users.

Getting Started with FaxCenter
Before you can start FaxCenter, you need to verify your operating system, install an image viewer if necessary, and 
be registered as a FaxCenter user on the Omtool server.

Using FaxCenter with Windows XP
If your computer is running the Windows® XP operating system, before you start FaxCenter, you need to install 
Imaging for Windows® Professional Edition (PRO), an image viewer that runs on Windows XP.
© 2006 by Omtool, Ltd. All rights reserved. Omtool, AccuRoute and the Company logo are trademarks of the Company. Trade names and trademarks of other companies appearing in this document are the property of their respective owners.
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For more information, go to: http://www.omtool.com/omtoolserver/v331/documentation/faxcenter/index.htm

Note: If your computer is running the Windows 2000 operating system, you do not need to install an imaged 
viewer. Windows 2000 includes Imaging for Windows.

Becoming a FaxCenter registered user
Before you can use FaxCenter, your network administrator must register you as a FaxCenter user on the Omtool 
server. After the administrator registers you, you can launch FaxCenter and connect to the Omtool server.

Before you connect to the Omtool server, you need to know:

• The name of the Omtool server in your organization.

• Your e-mail address.

• Your FaxCenter password.

You can obtain this information from your network administrator.

Starting FaxCenter
Use the following procedure to start FaxCenter:

To start FaxCenter:

1  Click START, select PROGRAMS, select OMTOOL, and then select FAXCENTER. The CONNECT 
TO SERVER dialog box appears.

If the CONNECT TO SERVER dialog box doesn’t appear automatically, go to Connecting to the 
Omtool server.

2  Type the machine name where the Omtool server is located in the SERVER text box.

3  Type your e-mail address in the E-MAIL text box.

4  Type your FaxCenter password in the PASSWORD text box. If you do not have a password. leave 
the text box blank.

5  Click CONNECT.
© 2006 by Omtool, Ltd. All rights reserved. Omtool, AccuRoute and the Company logo are trademarks of the Company. Trade names and trademarks of other companies appearing in this document are the property of their respective owners.
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Connecting to the Omtool server
Use the following procedure to connect to the Omtool server.

To connect to the Omtool server:

1  Click FILE on the menu bar and then select CONNECT. The CONNECT TO SERVER dialog box 
appears.

2  Type the machine name where the Omtool server is located in the SERVER text box.

3  Type your e-mail address in the E-MAIL text box.

4  Type your FaxCenter password in the PASSWORD text box. If you do not have a password. leave 
the text box blank.

5  Click CONNECT.

About fax expiration
Your network administrator must set an expiration period for faxes in FaxCenter. This means that when a fax has 
been in someone’s FaxCenter account for longer than a certain amount of time, the fax expires and disappears from 
the FaxCenter account. For example, if the expiration period for faxes is 72 hours, then a fax disappears from your 
FaxCenter account if you do not route the fax in three days.
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CHAPTER 2: UNDERSTANDING THE 
FAXCENTER CONSOLE
This chapter includes the following sections:

• Introducing the FaxCenter Console

• Using FaxCenter menus

• Using FaxCenter toolbars

• Using the FaxCenter Status bar

• Using fax lists

Introducing the FaxCenter Console
When you launch FaxCenter, the FaxCenter Console appears. This window consists of three main sections, as well 
as toolbars and a status bar.

Figure 2-1. The FaxCenter Console

Above: The FaxCenter Console contains three main sections, toolbars, and a status bar.
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Fax list
The left pane of the FaxCenter Console window displays a list of faxes. There are four lists in FaxCenter:

• New Items

• Processed Items

• Found Items

• Registration Pending Items

Page view
The upper right pane of the FaxCenter Console window displays a page from the selected fax.

Thumbnail images
The lower right pane of the FaxCenter Console window displays thumbnail images of all the pages in the fax. You 
can click on a thumbnail image to view it in the Page View.

Toolbars and status bar
The FaxCenter Console window also contains toolbars and a status bar:

• Standard toolbar - Includes shortcuts for major functions in FaxCenter.

• Image toolbar - Incudes shortcuts for viewing faxes.

• Annotation toolbar - Includes shortcuts for using annotation tools.

• Status bar - Displays information about faxes when you are logged in to FaxCenter.

List of keyboard shortcuts
Many FaxCenter features have keyboard shortcuts. These features are grouped by category:

Table 2-1. Keyboard shortcuts

Category Keyboard shortcut Function

Getting help F1 Open FaxCenter help

Printing faxes CTRL + P Print a fax

Routing faxes ALT + R
ESC

Route the selected fax
Enable Auto Route

Saving faxes CTRL + S Save a fax
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Changing the FaxCenter Console’s layout
To change the layout of the FaxCenter Console, select an icon on the Image toolbar:

Figure 2-2. The image toolbar

Above: The image toolbar allows you to manage how you view your image.

• View Full Page - Click  (View Full Page) to view only full pages of the fax in the FaxCenter 
Console window. Thumbnail images of pages in the fax are hidden.

• View Thumbnails - Click  (View Thumbnails) to view only thumbnail images of pages in the 
FaxCenter Console window. The full Page View of the fax is hidden.

• View Thumbnails and Image - Click  (View Thumbnails and Image) to view a page of the fax 
in the top pane of the FaxCenter Console window and thumbnail images of pages in the bottom 
pane.

Using FaxCenter menus
FaxCenter includes the following menus:

• File menu

• Edit menu

• View menu

• Tools menu

• Annotation menu

• Help menu

These menus are described in the following sections.

Viewing faxes Page Up
Page Down
ALT + Left arrow
ALT + Right arrow
ALT + Up arrow
ALT + Down arrow
ALT + Enter

Previous page
Next page
Rotate left
Rotate right
Flip the page
Flip the page
View fax properties

Table 2-1. Keyboard shortcuts

Category Keyboard shortcut Function
© 2006 by Omtool, Ltd. All rights reserved. Omtool, AccuRoute and the Company logo are trademarks of the Company. Trade names and trademarks of other companies appearing in this document are the property of their respective owners.
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File menu
Using the File menu, you can connect to the Omtool server, save and print faxes, and exit the program.

Figure 2-3. The File menu

Above: From the File menu, you can connect to the server, print, create a report, save, route to a DMS, 
and exit the program.

The File menu consists of the following items:

• CONNECT - Select this item to connect to the Omtool server.

• PRINT - Select this item to print the selected fax.

• REPORT OPTIONS- Select this item to view the history of the selected fax or all faxes in the list.

• SAVE AS - Select this item to save the selected fax.

• ROUTE TO [NAME OF DMS] - Select this item to route the selected fax to a Document 
Management System (DMS). (If you have not configured your DMS within FaxCenter, or you do not 
have a DMS installed, this item reads ROUTE TO FILE and the Save As window opens when you 
select it.

• EXIT - Select this item to exit FaxCenter.

Edit menu
Using the Edit menu, you can perform major tasks related to faxes, including routing, deleting, finding, releasing, 
reassigning, and editing faxes. The items available in the Edit menu depend upon which view you are looking at.
© 2006 by Omtool, Ltd. All rights reserved. Omtool, AccuRoute and the Company logo are trademarks of the Company. Trade names and trademarks of other companies appearing in this document are the property of their respective owners.
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Figure 2-4. The Edit menu in the Processed Items view

Above: The Edit menu differs depending on your view. In the Processed Items view, you can route an 
item, find a fax, delete a fax, release a fax, delete a page, append a page, insert a page, or reassign 
the fax.

The Edit menu contains the following items:

• ROUTE ITEM - Select this item to route selected faxes to a destination.

• FIND A FAX - Select this item to search the faxes in FaxCenter.

• MOVE TO PROCESSED - Select this item to move the selected fax from the New Items list to the 
Processed Items list. This option is available only when you are viewing the New Items list and only 
if you have permissions to move items from the New Items list to the Processed Items list.

• DELETE FAX - Select this item to delete the selected fax permanently from the Processed items list 
or the Found Items list. (You might not have permission to use this feature.)

• RELEASE FAX - Select this item to release the selected fax from Registration Pending to a secure 
destination. (You might not have permission to use this feature.)

Important! Some industries, such as health care, have regulations for delivery to secure destinations. You 
should handle sensitive faxes with caution, as there can be legal ramifications if they are mishandled. Ask 
your network administrator if you have questions about releasing faxes.

• DELETE PAGE - Select this item to delete the page that appears in the Page View pane.

• APPEND PAGE - Select this item to append an image file to the end of the selected fax.

• INSERT PAGE - Select this item to insert an image file before the current page in the selected fax.

• REASSIGN FAX - Select this item to assign the selected fax in the New Items list to another 
FaxCenter user.

View menu
Using the View menu, you can configure options for viewing faxes in FaxCenter, and change the list that appears in 
the Message List pane.
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Figure 2-5. The View menu

Above: The View menu allows you to change how you are viewing your faxes in FaxCenter.

The View menu contains the following items:

• ROTATE - Select this item to rotate the page, and then select one of the following options:

- LEFT - Select this option to rotate the current page of the fax 90 degrees to the left.

- RIGHT - Select this option to rotate the current page of the fax 90 degrees to the right.

- FLIP - Select this option to rotate, or flip, the current page of the fax 180 degrees.

- ROTATE ALL PAGES LEFT - Select this option to rotate all pages of the fax 90 degrees to the 
left.

- ROTATE ALL PAGES RIGHT - Select this option to rotate all pages of the fax 90 degrees to the 
right.

- FLIP All pages - Select this option to rotate, or flip, all pages of the fax 180 degrees.

• FIT TO - Select this item to fit the page into the Page View, and then select one of the following 
options:

- PAGE - Select this option to fit the entire page in the Page View pane.

- WIDTH - Select this option to fit the width of the page in the Page View pane.

- ZOOM OUT - Select this option and click on the fax.

- ZOOM IN - Select this option and click on the fax.

• GO TO PAGE - Select this item to go to a page in the fax, and then select one of the following 
options:

- NEXT - Select this option to go to the next page in the selected fax.

- PREVIOUS - Select this option to go to the previous page in the selected fax.

- LAST - Select this option to go to the last page in the selected fax.

- FIRST - Select this option to go to the first page in the selected fax.
© 2006 by Omtool, Ltd. All rights reserved. Omtool, AccuRoute and the Company logo are trademarks of the Company. Trade names and trademarks of other companies appearing in this document are the property of their respective owners.
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• NEW ITEMS - Select this item to view New Items in the list.

• PROCESSED ITEMS - Select this item to view Processed items in the list, and then select one of the 
following options:

- TODAY - Select this option to see Processed Items for today only.

- LAST TWO DAYS - Select this option to see Processed Items for the last two days only.

- THIS WEEK - Select this option to see Processed Items for this week only.

- THIS MONTH - Select this option to see Processed Items for this month only.

- ALL - Select this option to see all Processed Items.

• FOUND ITEMS - Select this item to view Found Items in the list.

• REGISTRATION PENDING ITEMS - Select this item to view Registration Pending Items in the list.

• TOOLBAR - Select this item to show or hide the Standard toolbar.

• IMAGE TOOLBAR - Select this item to show or hide the Image toolbar.

• ANNOTATION TOOLBAR - Select this item to show or hid e the Annotation toolbar.

• STATUS BAR - Select this item to show or hide the Status bar.

• PROPERTIES - Select this item to view the Properties of the selected fax.

Tools menu
Using the Tools menu, you can configure new fax notifications, configure and enable Auto Route, and enable or 
disable After Hours.

Figure 2-6. The Tools menu

Above: The Tools menu allows you to configure and use Auto Route and After Hours, configure your 
DMS, and set other options.

The Tools menu contains the following items:

• OPTIONS - Select this item to configure new fax notifications.

• AUTO ROUTE - Select this item to configure and enable Auto Route.

• AFTER HOURS - Select this item to enable or disable After Hours. (Your network administrator 
must grant you permission to use After Hours.)

• CONFIGURE DMS - Select this option to configure FaxCenter to work with your DMS. See 
(FaxCenter and DMS applications, p. 61) for more information on using FaxCenter with your DMS.
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Annotation menu
The Annotation menu contains tools that allow you to edit faxes by making notes and comments on them.

Figure 2-7. The Annotation menu

Above: The Annotation menu provides tools for marking up a fax in FaxCenter, just like you could on a 
hard copy.

The Annotation menu contains the following items:

• SHOW ANNOTATIONS - Show or hide annotations in the selected fax.

• SELECT ANNOTATIONS - Select a previously applied annotation so you can modify or delete it.

• FREEHAND LINE - Draw or write freehand on a fax.

• HIGHLIGHTER - Highlight sections of a fax.

• STRAIGHT LINE - Draw a straight line on a fax.

• HOLLOW RECTANGLE - Draw a rectangle without background color on a fax.

• FILLED RECTANGLE - Create a rectangle with a colored background on a fax.

• TYPED TEXT - Create text without a border or background color on a fax.

• ATTACH-A-NOTE - Create a note on a fax.

• TEXT FROM FILE - Insert text from a file into a fax.

• RUBBER STAMPS - Stamp a phrase on a fax.

• DELETE ANNOTATION - Delete annotations from a fax.

Help menu
Using the Help menu, you can access end-user help, and view version and copyright information for FaxCenter.

The Help menu contains the following items:
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Figure 2-8. Help menu

Above: The Help menu allows acces to the end-user help, and the version and copyright information 
for FaxCenter.

• HELP TOPICS - Select this item to open the end-user help for FaxCenter. (You can also open the 
end-user help by pressing F1 on the keyboard.)

• ABOUT FAXCENTER - Select this item to view version and copyright information for FaxCenter.

Using FaxCenter toolbars
FaxCenter includes the following toolbars:

• Standard toolbar

• Image toolbar

• Annotation toolbar

These toolbars are described in the following sections.

Standard toolbar
The Standard toolbar includes shortcuts for major functions in FaxCenter.

Figure 2-9. The Standard toolbar

Above: The Standard toolbar provides icons for common tasks.

These functions include:

• Connecting to the Omtool server.

• Saving a fax.

• Routing a fax to a DMS.

• Printing a fax.

• Generating a report.

• Changing the list.
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• Routing a fax.

• Going to a page in the fax.

• Enabling Auto Route.

You can move the Standard toolbar by clicking on the toolbar and dragging it anywhere in the FaxCenter Console 
window. Also, you can show and hide the Standard toolbar.

To show or hide the Standard toolbar:

• Click VIEW on the menu bar and select TOOLBAR to show the Standard toolbar, or clear the 
TOOLBAR option to hide the Standard toolbar.

Image toolbar
The Image toolbar includes shortcuts for viewing faxes. These shortcuts allow you to rotate images, drag pages, select 
an area for viewing, zoom in and out, and change the window layout.

Figure 2-10. The Image toolbar

Above: The image toolbar provides shortcuts for viewing faxes in FaxCenter.

You can move the Image toolbar by clicking on the toolbar and dragging it anywhere in the FaxCenter Console 
window. Also, you can show and hide the Image toolbar.

To show or hide the Image toolbar:

• Click VIEW on the menu bar and select IMAGE TOOLBAR to show the Image toolbar, or clear the 
IMAGE TOOLBAR option to hide the Image toolbar.

Annotation toolbar
The Annotation toolbar includes shortcuts for using annotation tools. Using annotation tools, you can mark up a fax 
using the same tools you would have available to you at your desk, such as drawing and writing instruments, a 
highlighter, sticky notes, etc.

Figure 2-11. The Annotation toolbar

Above: The Annotation toolbar provides shorcuts for using annotation tools.
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You can move the Annotation toolbar by clicking on the toolbar and dragging it anywhere in the FaxCenter Console 
window. Also, you can show and hide the Annotation toolbar.

To show or hide the Annotation toolbar:

• Click VIEW on the menu bar and select ANNOTATION TOOLBAR to show the Annotation toolbar, 
or clear ANNOTATION TOOLBAR to hide the Annotation toolbar.

Using the FaxCenter Status bar
The Status bar displays helpful information when you are connected to the Omtool server. The Status bar is located 
along the bottom of the window and looks similar to the following:

Figure 2-12. The Status bar

Above: The Status bar displays information when you are connected to the Omtool server.

Explaining the Status bar
The Status bar displays the following information:

• Dynamic information - This information changes as you use FaxCenter. Dynamic information 
includes tool tips that appear when you move your mouse over buttons in the window, and the 
current FaxCenter status.

• Number of faxes displayed in the window - This is the number of faxes in the list.

• Omtool server name - This is the name of the Omtool server in your organization. When you 
log in to FaxCenter, you connect to the Omtool server.

• Zoom setting - This is the current zoom setting at which you are viewing the fax. This information 
appears as a percentage of size. For example, 100% means that you are viewing the fax at its actual 
size.

• Page navigation information - This is the page number you are currently viewing and the total 
number of pages in the selected fax.

• Timer for fax locking - While you are viewing, annotating, or routing a fax, the fax becomes 
locked so that other FaxCenter users cannot access the fax. The fax lock timer displays how much 
longer the fax will remain locked.

Showing or hiding the Status bar
You can show and hide the Status bar.
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To show or hide the Status bar:

• Click VIEW on the menu bar, and select STATUS BAR to show the Status bar, or clear STATUS 
BAR to hide the Status bar.

Using fax lists
There are four lists in FaxCenter. Depending on your personal FaxCenter configuration you might be able to view 
all or some of these lists.

New Items
This list contains faxes that you have not routed or reassigned.

The Partial Fax column is blank if the fax is complete. If the fax is incomplete, the value Partial Fax appears in this 
column.

Figure 2-1. New Items list

Above: The New Items list contains faxes that have not been routed or reassigned.

Processed Items
This list contains faxes that you have routed. You can view faxes for today, for the last two days, for this week, for 
this month, or all faxes.
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Figure 2-2. Processed Items list

Above: The Processed Items list contains faxes that have been routed.

Found Items
This list contains faxes that were routed using the Find a Fax feature. A fax that appears in the Found Items list also 
appears in the New Items, Processed items, and Registration pending Items lists.

A fax in the Found Items list functions as it does in its native list. If you delete a fax in the Found Items list, therefore, 
the original fax is also deleted. If you route a new item, FaxCenter moves it from the New Items list to the Processed 
Items list.

Figure 2-3. Found Items list

Above: The Found Items list contains faxes that were routed using Find a Fax.
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Registration Pending Items
This list contains faxes that are waiting to be delivered to secure destinations.

Figure 2-4. Registration Pending list

Above: The Registration Pending list contains faxes that are waiting to be delivered to secure 
destinations. When the confirmation fax is received, the Omtool server will release these faxes to their 
secure destination.

Important! Some industries, such as health care, have regulations for delivery to secure destinations. You 
should handle sensitive faxes with caution, as there can be legal ramifications if they are mishandled. Ask 
your network administrator if you have questions regarding faxes in Registration Pending.

To change the list:

• Click VIEW on the menu bar, and select NEW ITEMS, PROCESSED ITEMS, FOUND ITEMS, or 
REGISTRATION PENDING ITEMS. If you select Processed Items, you must select one of the 
following options: TODAY, LAST TWO DAYS, THIS WEEK, THIS MONTH, or ALL.

Tip: You can also change the list by clicking buttons on the Standard toolbar.
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CHAPTER 3: WORKING WITH FAXES
This chapter includes the following sections:

• Viewing faxes

• Locking the fax

• Opening a fax

• Viewing fax properties

• Understanding fax viewing options

• Navigating faxes

• Saving faxes

• Printing faxes

• Deleting faxes

• Editing faxes

• Routing faxes

• Moving, re-routing, or reassigning faxes

• Using automated routing features

• Releasing faxes

• Finding faxes

• Checking the status of processed faxes

Viewing faxes
After you launch FaxCenter and connect to the Omtool server, you can view FaxCenter faxes.

Viewing all faxes
You might be able to view all faxes in your organization if you have been granted permission do so, and if your 
network administrator has configured FaxCenter to display different faxes to each FaxCenter user.

For example, suppose there are two other FaxCenter users in your organization. John reviews and routes faxes to 
the Sales department, and Mary reviews and routes faxes to the Production department. You can view all the faxes 
in your organization, including the faxes that John and Mary see, if you have been granted permission to view all 
FaxCenter faxes. When you view the Processed Items list, therefore, you should see the faxes that have been routed 
by every FaxCenter user in your organization.
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Viewing the entire fax or first page only
As a FaxCenter user, you have been assigned permissions to use FaxCenter features. Depending on your permissions, 
you might see the first page of the fax or the entire fax.

• First page only - Because the first page of a fax usually contains instructions for delivering the fax, 
you can use this information to route the fax to the appropriate destination. You can edit the first 
page using annotation tools.

When you route the fax, the recipient receives the entire fax, including the first page that you 
viewed in FaxCenter, along with any edits or annotations you made.

• Entire fax - You can view and edit the entire fax.

When you route the fax, the recipient receives the entire fax including any edits or annotations you 
made.

Locking the fax
When you select a fax in the list, FaxCenter locks the fax so that other FaxCenter users cannot view, edit, or route 
the fax while you work with it.

Indicating a locked fax
There are two visual indicators of a locked fax:

• A timer appears in the Status bar. The timer counts down, indicating how much longer the fax 
remains locked.

• A lock icon appears next to the fax in the list.

Locking faxes
When you select a fax and it becomes locked, other FaxCenter users cannot access the fax. When you select a 
different fax, the other fax which had been locked becomes available to other FaxCenter users.

Accessing locked faxes
If another FaxCenter user is working with a fax and you try to access the same fax, a fax box indicates that the fax 
is locked by another FaxCenter user.
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Editing and annotating faxes
When the time expires, you lose any changes you made to the fax, including edits and annotations. You must route 
the fax before the time expires, therefore, so that the fax recipients receive your edits and annotations.

Opening a fax
Use the following procedure to open a fax.

To open a fax:

1  Click VIEW on the menu bar, and select NEW ITEMS, PROCESSED ITEMS, FOUND ITEMS, or 
REGISTRATION PENDING ITEMS.

2  Select the fax you want to open. The fax appears in the FaxCenter window.

Viewing fax properties
When you view the properties of a fax in FaxCenter, the Message Properties dialog box appears.

The Message Properties dialog box contains three tabs:

• General
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• Attachments

• Journal

The faxes residing in the Registration Pending list contain three additional tabs in the Message Properties dialog box. 
They are:

• Recipient

• Sender

• Confirmations

There are two ways to view fax properties; using the View menu or the shortcut menu.

Note: You cannot use the shortcut menu to view the properties of faxes in the Registration Pending list. 
You must use the View menu to view these properties. Additionally, the fax properties for Registration 
Pending faxes include three additional tabs: Recipient, Sender, and Confirmation.

Using the View menu
Use the following procedure to view fax properties using the View menu.

To view fax properties using the View menu:

1  Select a fax in the list.

2  Click VIEW on the menu bar and then select PROPERTIES. The MESSAGE PROPERTIES dialog box 
appears.

3  Click the GENERAL, ATTACHMENTS, and JOURNAL tabs to view all properties for the selected 
fax.

Using the shortcut menu
Use the following procedure to view fax properties using the shortcut menu.

To view fax properties using the shortcut menu:

1  Right-click on a fax in the list and select PROPERTIES. The MESSAGE PROPERTIES dialog box 
appears.

2  Click the GENERAL, ATTACHMENTS, and JOURNAL tabs to view all properties for the selected 
fax.

Viewing fax properties - General tab
The General tab displays information about the properties of a fax.
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Figure 3-1. General properties of a fax

Above: The General tab displays informatioin about the fax.

The fields on the General tab are:

• RECEIVED - The date and time the Omtool server received the inbound fax for processing.

• RECEIVED BY - The name of the connector that received the fax.

• ROUTED TO - The final system destination to which the fax was routed.

• CSI - The CSI is the identification of the receiving fax machine.

• ANI - The ANI is the caller ID of the telephone line used to transmit the fax.

• DID/DTMF - The DID/DTMF is the extension of the fax destination.

• TSI - The TSI is the identification of the sending fax machine.

• JOB ID - The Job ID is the unique number that identifies a fax on the Omtool server.

• STATUS - As the Omtool server processes a fax for delivery, the status can be Pending, Successful, 
or Failed. View the fax journal for more information about the current processing stage of the fax.

Viewing fax properties - Attachments tab
The Attachments tab displays information about attachments to a fax.
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Figure 3-2. Attachment properties of a fax

Above: This tab lists the properties for any attachments to the fax.

The fields on the Attachments tab are:

• [X] ATTACHMENTS WERE SPECIFIED - This is the total number of attachments to the fax.

• ORIGINAL PATHNAME - This is the path name of an attachment to the fax. Each attachment has a 
unique original path name.

• VIEW - Select and attachment, and then click VIEW to view it.

Viewing fax properties - Journal tab
The Journal tab displays information about all events related to a fax on the Omtool server.
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Figure 3-3. Journal properties of a fax

Above: In the Journal properties of a fax, you can see all event information for the fax.

Each item in the journal includes:

• DATE - The date and time of an event on the Omtool server.

• JOURNAL ENTRY - The state of a fax and a description of the event that occurred in that state.

Viewing fax properties - Recipient tab
The Recipient tab only appears on faxes in the Registration Pending list, and displays information about the recipient 
of a fax.
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Figure 3-4. Recipient properties of a fax

Above: This tab only appears when a fax is in the Registration Pending list, and displays information 
about the recipient of the fax.

The fields on the Recipient tab are:

• RECEIVED - The name of the fax’s recipient.

• ADDRESS - The address information contained in the cover page of the fax.

• REFERENCE - The reference information (or subject if sent from an e-mail address) of the fax.

• ALL - the variable names and values associated with the variables of the fax’s recipient.

Viewing fax properties - Sender tab
The Sender tab only appears on faxes in the Registration Pending list, and displays information about the sender of a 
fax.
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Figure 3-5. Sender properties of a fax

Above: This tab only appears when a fax is in the Registration Pending list, and displays information 
about the sender of the fax.

The fields on the Sender tab are:

• SENDER - The name of the fax’s sender.

• ADDRESS - The address information contained in the cover page of the fax.

• COVER PAGE - The name of the cover page of the fax.

• REFERENCE - The reference information (or subject if sent from an e-mail address) of the fax.

• ALL - The variable names and values associated with the variables of the fax’s sender.

Viewing fax properties - Confirmations tab
The Confirmations tab only appears on faxes in the Registration Pending list, and displays information about what 
notifications are sent with the fax.
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Figure 3-6. Confirmation properties of a fax

Above: This tab only appears when a fax is in the Registration Pending list, and displays information 
about what notifications are sent with the fax.

The fields on the Confirmations tab are:

• NUMBER OF NOTIFICATIONS - The number of notifications attached to the fax.

• NOTIFICATION DETAILS - Details of the notifications attached to the fax. The information includes:

- Files

- Destination

- Type

Understanding fax viewing options
There are several ways you can modify the view of a page in a fax.

Rotating pages
When you rotate a page, you change your view of the fax. You can rotate pages left and right, and flip pages 180 
degrees.

To rotate the pages of a fax:

1  Select a fax in the list.

2  Click VIEW on the menu bar, select ROTATE, and then select an option.

- LEFT - Rotate the current page in the fax 90 degrees to the left.
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- RIGHT - Rotate the current page in the fax 90 degrees to the right.

- FLIP - Rotate the current page in the fax 180 degrees.

- ROTATE ALL PAGES LEFT - Rotate all pages in the fax 90 degrees to the left.

- ROTATE ALL PAGES RIGHT - Rotate all pages in the fax 90 degrees to the right.

- FLIP ALL PAGES - Rotate all pages in the fax 180 degrees.

Tip: You can also rotate the pages of a fax using keyboard shortcuts or the Image toolbar.

Zooming in and out
You can zoom in and out while viewing a fax.

To adjust the zoom for viewing a fax, do one of the following:

• Go to the Image toolbar, select the ZOOM IN  or ZOOM OUT  tool, and click on the fax.

• Go to the Image toolbar, expand the ZOOM drop-down menu, and select a zoom setting.

• Click VIEW on the menu bar, select FIT TO, and then select an option:

- PAGE - Fit the entire page in the Page View pane.

- WIDTH - Fit the width of the page in the Page View pane.
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- ZOOM OUT - To zoom out, select this option and click on the fax.

- ZOOM IN - To zoom in, select this option and click on the fax.

Dragging pages
You can drag pages in the Page View pane. When you drag a page, you can move it in the Page View pane without 
having to use the scroll bars to change your view of the fax.

To drag a page in a fax:

1  Select a fax in the list.

2  Go to the Image toolbar, select the ZOOM IN tool, and click on the fax one or more times until the 
zoom setting is appropriate for your viewing needs.

3  Select the DRAG IMAGE  tool on the Image toolbar.

4  Click on the fax in the Page View pane and drag the page.

Selecting an area
You can select an area for viewing. When you select an area by clicking and dragging the mouse, the area you selected 
appears in the Page View pane.

To select an area of a fax for viewing:

1  Select a fax in the list.

2  Go to the Image toolbar, and select the SELECT AREA  tool.

3  Click on the fax in the Page View pane, and drag the mouse across the area you want to view. The 
area you selected appears in the Page View pane.

Navigating faxes
As you view a fax in FaxCenter, you can navigate the fax by going to the next, previous, first, or last page, or by 
browsing thumbnail images of pages.

Going to a page in a fax
You can jump to the next, previous, first, or last page of a fax.
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Figure 3-7. Go to Page menu

Above: The Go To Page menu allows you to go to the next page, the previous page, the last page, or 
the first page.

To go to a page in a fax:

• Click VIEW on the menu bar, select GO TO PAGE, and select an option:

- NEXT - Select this option to go to the next page in the fax.

- PREVIOUS - Select this option to go to the previous page in the fax.

- LAST - Select this option to go to the last page in the fax.

- FIRST - Select this option to go to the first page in the fax.

Browsing thumbnail images of pages

Note: In order to navigate a fax using thumbnail images, your FaxCenter Console must be configured to 
display both pages and thumbnail images.

To browse thumbnail images:

• Click on a thumbnail image in the Thumbnails pane. The page appears in the Page View pane.

Saving faxes
Using FaxCenter, you can save faxes to your computer or to another computer on your organization’s network. You 
can also save faxes to your organization’s Document Management System (DMS).

When you save a fax, it is stored in TIF format, a file format for images.
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To save a fax:

1  Select the fax in the list.

2  Click FILE on the menu bar, and select SAVE AS.

3  Select a location for the file and type a file name for the fax in the FILE NAME text box.

4  Click SAVE.

Printing faxes
Using FaxCenter, you can print faxes. When printing a fax, you can select the print format and choose whether you 
want to print your annotations.

To print a fax:

1  Select one or more faxes in the list.

2  Click FILE on the menu bar, and select PRINT.

3  Click the IMAGE OPTIONS tab. Expand the PRINT FORMAT menu, and select an option:

- ACTUAL SIZE - Select this option to print the fax at its actual size.

- FIT TO PAGE - Select this option if you want each page of the fax to fill a single piece of paper.

- PIXEL TO PIXEL - Select this option to print the fax with each pixel in the image corresponding 
to one pixel on the printed page. This affects the size of the printed fax.
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4  Clear PRINT DISPLAYED ANNOTATIONS if you do not want to include your annotations in the 
printed fax.

5  Click APPLY.

6  Click the GENERAL tab, and configure the print settings.

7  Click PRINT.

Deleting faxes
Depending on your FaxCenter permissions, you can delete faxes in the Processed Items list and Found Items list.

Tip: You can keep a backup copy of a fax by saving it.
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To delete a fax:

1  View the PROCESSED ITEMS list or FOUND ITEMS list, and select the fax you want to delete.

2  Click EDIT on the menu bar, and select DELETE FAX.

Editing faxes
FaxCenter allows you to edit faxes by inserting, deleting, and appending pages, or by making annotations.

Inserting, deleting, and appending pages to documents
Using FaxCenter, you can delete a page from the fax, append a page to the fax, and insert pages into a fax. For 
example, you might want to delete pages that do not pertain to the recipient, or you might want to append or insert 
pages to add information to the fax.

• DELETE A PAGE - Delete the current page that appears in the Page View pane.

• APPEND A PAGE - Add a TIF file to the end of a fax. When you append a page to the fax, FaxCenter 
prompts you to select a TIF file. After you select a TIF file, FaxCenter adds the file to a new page at 
the end of the fax.

• INSERT A PAGE - Insert a TIF file into a fax. when you insert a page, FaxCenter prompts you to 
select a TIF file. FaxCenter inserts the TIF file on a new page before the current page that appears in 
the Page View pane.

Deleting a page from a fax
Use the following procedure to delete a page from a fax.

To delete a page from a fax:

1  Select a fax in the list.

2  Navigate to the page you want to delete.
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3  Click EDIT on the menu bar, and select DELETE PAGE. FaxCenter removes the page from the fax.

Appending a page to a fax
Use the following procedure to append a page to a fax.

To append a page to a fax:

1  Select a fax in the list.

2  Click EDIT on the menu bar, and select APPEND PAGE.

3  Select the TIF file you want to append to the fax, and click OPEN. FaxCenter adds the TIF file to a 
new page at the end of the fax.
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Inserting a page into a fax
Use the following procedure to insert a page into a fax.

To insert a page into a fax:

1  Select the fax in the list.

2  Click EDIT on the menu bar, and select INSERT PAGE.

3  Select the TIF file you want to insert, and click OPEN. FaxCenter inserts the TIF file on a new page 
before the current page that appears in the Page View pane.

Making annotations
You can view and annotate faxes in FaxCenter before you rout them. Using annotation tools, you can mark up a fax 
using the same tools you would have available to you on your desk, such as drawing and writing instruments, a 
highlighter, sticky notes, etc. Furthermore, you can edit annotations after you create them, show or hide annotations 
as you view a fax, and modify the properties of an annotation.

Whether you have permissions to view the entire fax or only the first page, you can use all the editing features 
available in FaxCenter.

You can access annotation tools from the Annotation menu and the Annotation toolbar.

For example, suppose you need to route a fax to a recipient and you want to make notes on the fax to bring the 
recipient’s attention to specific parts of the fax. You can make notes on the fax using typed text, a highlighter, notes, 
lines, rectangles, rubber stamps, and more.

FaxCenter annotation tools include:

• Drawing a freehand line (p. 39)

• Using the highlighter tool (p. 40)

• Drawing a straight line (p. 40)

• Drawing a hollow rectangle. (p. 40)

• Drawing a filled rectangle (p. 41)

• Entering typed text (p. 41)
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• Attaching a note (p. 41)

• Inserting text from a file (p. 42)

• Using a rubber stamp (p. 42)

After adding annotations to a fax, you can modify them by:

• Showing or hiding annotations (p. 43)

• Moving annotations (p. 43)

• Resizing annotations (p. 44)

• Editing annotation text (p. 44)

• Deleting annotations (p. 44)

• Modifying annotation properties (p. 45)

Locking faxes and annotations
While you edit a fax, it remains locked for a set amount of time. When the time expires, you lose any changes you 
made to the fax, including edits and annotations. You must route the fax before the time expires, therefore, so that 
fax recipients receive your edits and annotations.

The fax lock timer displays how much time you have left to annotate and route a fax.

Using annotation tools
Annotation tools let you mark up a fax in FaxCenter just like you would at your desk. The available annotation tools 
are described in the following sections.

Drawing a freehand line
The Freehand Line tool draws or writes freehand on the fax.

To draw a freehand line:

1  Click ANNOTATION on the menu bar, and select SHOW ANNOTATIONS.

2  Click ANNOTATION on the menu bar, and select FREEHAND LINE, or, go to the Annotation 
toolbar and select the FREEHAND LINE  tool.

3  Go to the Page View pane, click and drag the mouse on the fax, and release the mouse button. 
(Repeat this step to draw additional freehand lines.)

4  Click ANNOTATION on the menu bar, and select SELECT ANNOTATIONS to turn off the 
Freehand Line tool, or, go to the Annotation toolbar and select the SELECT ANNOTATIONS  
tool.
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Using the highlighter tool
The Highlighter tool highlights areas of the fax.

To use the highlighter tool:

1  Click ANNOTATION on the menu bar, and select SHOW ANNOTATIONS.

2  Click ANNOTATION on the menu bar, and select HIGHLIGHTER, or, go to the Annotation toolbar 
and select the HIGHLIGHTER  tool.

3  Go to the Page View pane, click and drag the mouse on the fax, and release the mouse button. 
(Repeat this step to highlight additional areas.)

4  Click ANNOTATION on the menu bar, and select SELECT ANNOTATIONS to turn off the 
Highlighter tool, or, go to the Annotation toolbar and select the SELECT ANNOTATIONS  tool.

Drawing a straight line
The Straight Line tool draws a straight line on the fax.

To draw a straight line:

1  Click ANNOTATION on the menu bar, and select SHOW ANNOTATIONS.

2  Click ANNOTATION on the menu bar, and select STRAIGHT LINE, or, go to the Annotation 
toolbar and select the Straight Line  tool.

3  Go to the Page View pane, click and drag the mouse on the fax, and release the mouse button. 
(Repeat this step to draw additional straight lines.)

4  Click ANNOTATION on the menu bar, and select SELECT ANNOTATIONS to turn off the Straight 
Line tool, or, go to the Annotation toolbar and select the SELECT ANNOTATIONS  tool.

Drawing a hollow rectangle.
The Hollow Rectangle tool draws a rectangle without background color on the fax. You can move or resize the 
rectangle.

To draw a hollow rectangle:

1  Click ANNOTATION on the menu bar, and select SHOW ANNOTATIONS.

2  Click ANNOTATION on the menu bar, and select HOLLOW RECTANGLE, or, go to the 
Annotation toolbar and select the HOLLOW RECTANGLE  tool.

3  Go to the Page View pane, click and drag the mouse on the fax, and release the mouse button. 
(Repeat this step to draw additional hollow rectangles.)

4  Click ANNOTATION on the menu bar, and select SELECT ANNOTATIONS to turn off the Hollow 
Rectangle tool, or, go to the Annotation toolbar and select the SELECT ANNOTATIONS  tool.
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Drawing a filled rectangle
The Filled Rectangle tool creates a rectangle with a colored background on the fax.

To draw a filled rectangle:

1  Click ANNOTATION on the menu bar, and select SHOW ANNOTATIONS.

2  Click ANNOTATION on the menu bar, and select FILLED RECTANGLE, or, go to the Annotation 
toolbar and select the FILLED RECTANGLE  tool.

3  Go to the Page View pane, click and drag the mouse on the fax, and release the mouse button. 
(Repeat this step to draw additional filled rectangles.)

4  Click ANNOTATION on the menu bar, and select SELECT ANNOTATIONS to turn off the Filled 
Rectangle tool, or, go to the Annotation toolbar and select the SELECT ANNOTATIONS  tool.

Entering typed text
The Typed Text tool creates text without a border or background color on the fax.

To enter typed text:

1  Click ANNOTATION on the menu bar, and select SHOW ANNOTATIONS.

2  Click ANNOTATION on the menu bar, and select TYPED TEXT, or, go to the Annotation toolbar 
and select the TYPED TEXT  tool.

3  Go to the Page View pane, click on the fax where you want to add text, and type text. (Repeat this 
step to add additional text.)

4  Click ANNOTATION on the menu bar, and select SELECT ANNOTATIONS to turn off the Typed 
Text tool, or, go to the Annotation toolbar and select the SELECT ANNOTATIONS  tool.

Attaching a note
The Attach-a-Note tool creates a note on the fax. You can move or resize the note.

To attach a note:

1  Click ANNOTATION on the menu bar, and select SHOW ANNOTATIONS.

2  Click ANNOTATION on the menu bar, and select ATTACH-A-NOTE, or, go to the Annotation 
toolbar and select the ATTACH-A-NOTE  tool.

3  Go to the Page View pane, click on the fax where you want to attach a note, and type text. (Repeat 
this step to attach additional notes.)

4  Click ANNOTATION on the menu bar, and select SELECT ANNOTATIONS to turn off the 
Attach-a-Note tool, or, go to the Annotation toolbar and select the SELECT ANNOTATIONS  
tool.
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Inserting text from a file
The Text from File tool inserts text from a file and places it on a fax.

To insert text from a file:

1  Click ANNOTATION on the menu bar, and select SHOW ANNOTATIONS.

2  Click ANNOTATION on the menu bar, and select TEXT FROM FILE, or, go to the Annotation 
toolbar and select the TEXT FROM FILE  tool.

3  Go to the Page View pane, click on the fax where you want to add the text.

4  Select the file and click OPEN. FaxCenter inserts the text into the fax.

5  Click ANNOTATION on the menu bar, and select SELECT ANNOTATIONS to turn off the Text 
From File tool, or, go to the Annotation toolbar and select the SELECT ANNOTATIONS  tool.

Using a rubber stamp
The Rubber Stamp tool stamps a phrase on a fax. You can move the stamp.

To use a rubber stamp:

1  Click ANNOTATION on the menu bar, and select SHOW ANNOTATIONS.

2  Click ANNOTATION on the menu bar, and select RUBBER STAMPS, or, go to the Annotation 
toolbar and select the RUBBER STAMPS  tool.

3  Modify the rubber stamps:

Create Text

a Click CREATE TEXT to create a new stamp with text.

b Type the stamp name and stamp text. Consider the following options:

Click DATE to insert the current date in the stamp.

Click TIME to insert the current time in the stamp.

Click FONT if you want to configure font properties. Configure the font properties and click 
OK.
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Create Image

a Click CREATE IMAGE to create a new stamp with an image.

b Type the stamp name.

c Click BROWSE, select the file for the stamp, and click OPEN.

d Click OK to create the stamp.

Delete

a Select a stamp in the list and click DELETE.

b Click YES to delete the stamp.

Edit

a Select a stamp in the list, and click EDIT to edit the stamp.

b Configure the stamp properties and click OK.

4  Select the rubber stamp you want to use, and click OK.

5  Go to the Page View pane, click on the fax where you want the stamp to appear.

6  Click ANNOTATION on the menu bar, and select SELECT ANNOTATIONS to turn off the Rubber 
Stamps tool, or, go to the Annotation toolbar and select the SELECT ANNOTATIONS  tool.

Showing or hiding annotations
Use the following procedure to show or hide annotations.

To show or hide annotations in a fax:

1  Select the fax that has the annotations you want to show or hide.

2  Click ANNOTATIONS on the menu bar, and select SHOW ANNOTATIONS t o display annotations 
in the fax, or clear SHOW ANNOTATIONS to hide annotations in the fax.

Moving annotations
Use the following procedure to move an annotation.
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To move an annotation:

1  Click ANNOTATION on the menu bar, and select SHOW ANNOTATIONS.

2  Click ANNOTATION on the menu bar, and select SELECT ANNOTATIONS.

3  Select the annotation you want to move.

4  Click on a handle and drag the annotation. Release the mouse button when the annotation is placed 
where you want it.

Resizing annotations
Use the following procedure to resize an annotation. You can resize highlighted sections, straight lines, hollow and 
filled rectangles, attached notes, and text boxes with text from files.

To resize an annotation:

1  Click ANNOTATION on the menu bar, and select SHOW ANNOTATIONS.

1  Click ANNOTATION on the menu bar, and select SELECT ANNOTATIONS.

2  Select the annotation you want to resize.

3  Click on a control point and drag it. Release the mouse button when the annotation is the desired 
size.

Editing annotation text
Use the following procedure to edit annotation text.

To edit annotation text:

1  Click ANNOTATION on the menu bar, and select SHOW ANNOTATIONS.

2  Click ANNOTATION on the menu bar, and select SELECT ANNOTATIONS.

3  Select the annotation you want to edit.

4  Edit the annotation text.

5  Click on another part of the fax to stop editing the text.

Deleting annotations
Use the following procedure to delete an annotation.

To delete an annotation:

1  Click ANNOTATION on the menu bar, and select SHOW ANNOTATIONS.

2  Click ANNOTATION on the menu bar, and select SELECT ANNOTATIONS.
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3  Click on the annotation you want to delete.

4  Click ANNOTATION on the menu bar, and select DELETE ANNOTATION, or, go to the 
Annotation toolbar and select the DELETE ANNOTATION  tool.

Modifying annotation properties
After you make annotations on faxes, you can modify their properties. Annotation properties include:

• COLOR - Select a standard or custom color for an annotation.

• LINE WIDTH - Set the width of a line in pixels for freehand lines, straight lines, and hollow 
rectangles.

• TRANSPARENCY - Make an annotation transparent, so that you can view the contents of the fax 
underneath the annotation. This option is available for freehand lines, highlighted areas, straight 
lines, hollow rectangles, and filled rectangles.

• TEXT PROPERTIES - Modify the text properties of all annotations with text, including typed text, 
text from a file, text on an attached note, and rubber stamp text. Text properties include font, font 
style, size, effects, color, and script.

Modifying lines, rectangles, or highlighted areas
Use the following procedure to modify the annotation properties of freehand lines, straight lines, hollow rectangles, 
filled rectangles, or highlighted areas.

To modify the annotation properties of lines, rectangles, or highlighted areas:

1  Click ANNOTATION on the menu bar, and select SHOW ANNOTATIONS.

2  Click ANNOTATION on the menu bar, and select Select Annotations.

3  Right-click the annotation you want to modify. (You cannot edit the properties of multiple 
annotations.)

4  In the WIDTH spin box, enter the desired line width in pixels if you modifying a freehand line, 
straight line, or hollow rectangle.

5  Click a color if you want to change the color of a freehand line, straight line, or hollow rectangle.

6  Select TRANSPARENT if you want the annotation to be transparent to the fax.

7  Click OK.
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Modifying text, notes, or rubber stamps
Use the following procedure to modify the annotation properties of typed text, attached notes, text from files, or 
rubber stamps.

Tip: If the selected annotation is an attached note, you need to click FONT to open the text properties 
window.

To modify the annotation properties of text, notes, or rubber stamps:

1  Click ANNOTATION on the menu bar, and select SHOW ANNOTATIONS.

2  Click ANNOTATION on the menu bar, and select SELECT ANNOTATIONS.

3  Right-click the annotation you want to modify. (You cannot edit the properties of multiple 
annotations.)

4  Configure the text properties by selecting the font, font style, size, effects, color, or script.

5  Click OK.

6  Select a color for the attached note and click OK, or click PALETTE and select a color for the 
attached note, and then click OK if you are modifying an attached note.

Routing faxes
Using FaxCenter, you can route new faxes and processed faxes to e-mail recipients, fax machines, and printers in the 
local area network.

Single, multiple, and partial fax routing
In FaxCenter, you can rout a single fax, multiple faxes, or a partial fax.

Fax processing and delivery
When you route a fax, the Omtool server delivers it to the specified destination and records information about the 
status of the fax in the fax journal. FaxCenter moves the fax from the New Items list to the Processed Items list.

Original sender information
When you route a fax, you can provide information about the original sender of the fax.
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Processed faxes
After a fax has been routed or processed, you can send the fax to another destination. If you receive a new fax in 
FaxCenter that should be re-directed to another FaxCenter user, you can reassign the fax.

Routing destinations
Using FaxCenter, you can route faxes to e-mail recipients, fax machines, and printers in the local area network. You 
can route single or multiple faxes at the same time to one or more specified destinations.

• E-mail recipients - When you route faxes to e-mail recipients, the Omtool server sends the 
recipient an e-mail notification fax indicating that you have routed the fax to them. The Omtool 
server attaches the fax to the notification fax as a PDF file. The recipient of the fax can view the fax 
using Adobe® Acrobat® or Acrobat® Reader.

• Fax machines - You can route faxes to fax machines using a fax number. The fax machine will 
likely print the fax, unless the fax machine is configured to handle faxes differently.

For example, when someone outside your organization sends a document to a fax number in your 
organization, the Omtool server likely routes the fax to an e-mail recipient or to a FaxCenter user. 
Therefore, when you route a fax to a fax destination, your fax is subject to the rules by which that 
fax destination hands faxes. This might include printing the fax on the fax machine, or routing the fax 
to an e-mail account or other device in the organization’s network.

• Printers - You can route faxes to printers in the local area network.

• Document Management Systems (DMS) - You can route faxes to a DMS where they can be 
profiled and stored. See http://www.omtool.com/documentation/dmslibraries/v21/
DMSLib21_ConfigurationGuide.pdf for a list of supported DMS applications.

Specifying a routing destination
When you route a fax, you must specify a destination. A routing dialog box provides you with a list of possible 
destinations for faxes; this list includes e-mail users and distribution lists in your organization’s network, and printing 
devices to which your computer has access. From the list provided, you can select any e-mail addresses and printing 
devices as routing destinations, and you can add e-mail destinations and fax machine numbers.

Routing destination naming guidelines
When you add new routing destinations for a fax, use the following guidelines:

• For an e-mail recipient, type the e-mail address as if you are addressing an e-mail message. Use the 
standard Internet addressing format, name@companyname.com. For example: 
jsmith@omtool.com.

• For a fax machine, type the number of the fax machine. Include the area code if necessary. Spaces, 
dashes, and parentheses are allowed. For example: 6035551111 or 5551111 or 603-555-
1111 or (603) 555-1111.
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Using additional routing features
In addition to routing faxes, you can:

• Reassign faxes to other FaxCenter users - You can redirect faxes to other FaxCenter users 
who can route them to the appropriate destinations.

• Route all new faxes automatically - You can configure FaxCenter to route all new faxes 
automatically to a specified destination.

• Use After Hours - You can use After Hours when no FaxCenter users are available to process 
faxes. When you enable After Hours, the Omtool server handles your faxes according to a special 
set of rules that are configured by your network administrator.

Routing single faxes
You can route and re-route single faxes. When you route a fax, you must specify a destination for the fax and the 
pages you want to send. The destination can be any e-mail address, fax machine, printer, or DMS in the local area 
network. The Omtool server sends the fax from FaxCenter to the destination you specify.

To route a fax to e-mail recipients, printers, and fax machines:

1  Select a new or previously routed fax in the list.

2  Click EDIT on the menu bar, and select ROUTE ITEM.

3  Select a destination from the list on the left and click ADD RECIPIENT, or type a destination in the 
TYPE DESTINATION OR SELECT FROM LIST text box and click ADD.

Note: You can route the fax to multiple destinations in this step. To route the fax to multiple destinations, 
repeat this step until you have added all the destinations to which you want the Omtool server to deliver 
the fax.

4  In the PAGES TO ROUTE text box, and indicate the pages you want to route by selecting ALL 
PAGES from the drop-down menu or typing the page numbers in the text box.
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5  Go to the ROUTING TRANSACTION DESCRIPTION section, type the name of the original sender 
in the NAME text box, the original sender’s company name in the COMPANY text box, and your 
comments about the fax in the COMMENTS text box.

6  Click ROUTE. The Omtool server prepares and sends the fax to the destination(s) you specified, 
and FaxCenter moves the fax to the Processed Items list.

Routing multiple faxes
You can route and re-route multiple faxes at the same time from FaxCenter. The faxes you select are combined and 
ordered chronologically by their time stamps; the oldest fax you select appears at the beginning of the combined fax. 
When you route multiple faxes, you must specify a destination and the pages you want to send in the combined fax. 
The Omtool server sends the combined fax from FaxCenter to the destination you specify.

To route multiple faxes:

1  Select two or more new or previously routed faxes in a list.

- To select multiple faxes: Select a fax, press and hold the CTRL key, and then continue 
selected faxes.

- To select a group of faxes: Select the first fax in the group, press and hold the SHIFT key, and 
then select the last fax in the group.

2  Click EDIT on the menu bar, and select ROUTE ITEM.

3  Select a destination from the list on the left and click ADD RECIPIENT, or type a destination in the 
TYPE DESTINATION OR SELECT FROM LIST text box and click ADD.

Note: You can route faxes to multiple destinations in this step. To route faxes to multiple destinations, 
repeat this step until you have added all the destinations to which you want the Omtool server to deliver 
the faxes.

4  Go to the ROUTING TRANSACTION DESCRIPTION section, type the name of the original sender 
in the NAME text box, the original sender’s company name in the COMPANY text box, and your 
comments about the fax in the COMMENTS text box.
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5  Click ROUTE. The Omtool server prepares and sends the combined faxes to the destination(s) you 
specified, and FaxCenter moves them to the Processed Items list.

Routing partial faxes
You can route part of a fax by specifying the page numbers you want to send.

When you specify the page numbers you want FaxCenter to route, FaxCenter routes only these pages to the routing 
destination.

When you specify page numbers, use the following guidelines:

• Indicate a single page by typing the page number. for example: 2

• Indicate a page range by typing the first page number in the range, a hyphen, and the last page 
number in the range. For example: 2-5

• Separate page numbers and page ranges with a comma. For example: 2, 4-7, 9

Moving, re-routing, or reassigning faxes
Using FaxCenter, you can move, re-route, or reassign faxes.

Moving faxes to Processed Items
After you route a fax, FaxCenter automatically moves the fax from the New Items list to the Processed Items list. 
This convenient feature keeps you organized and allows you to identify new faxes easily. You can also move faxes to 
the Processed Items list manually, even if you have not routed them.

After you route a new fax, FaxCenter moves it from the new Items list to the Processed Items list. This allows you 
to maintain only new faxes in the New Items list, and keep a record of the faxes you have previously routed in the 
Processed Items list. You can route and re-route any fax in the Processed Items list.

To move a fax from the New Items list to the Processed Items list:

1  Select one or more faxes in the NEW ITEMS list.

2  Right-click the fax(s) you selected in the New Items list and select MOVE TO PROCESSED. 
FaxCenter moves the selected fax(s) from the New Items list to the Processed items list.
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Re-routing faxes
After you have routed a fax and FaxCenter moves it to the Processed Items list, you can route the fax to another 
destination. You can route a fax again and again, as long as the fax appears in FaxCenter.

Just as you can route single or multiple faxes in the New Items list, you can route single or multiple faxes in the 
Processed Items list.

Re-routing a single fax
Use the following procedure to re-route a single fax.

To re-route a fax:

1  Right-click a fax in the PROCESSED ITEMS list, and select ROUTE.

2  Select a destination from the list on the left and click ADD RECIPIENT, or type a destination in the 
TYPE DESTINATION OR SELECT FROM LIST text box and click ADD.

Note: You can route faxes to multiple destinations in this step. To route faxes to multiple destinations, 
repeat this step until you have added all the destinations to which you want the Omtool server to deliver 
the faxes.

3  In the PAGES TO ROUTE text box, and indicate the pages you want to route by selecting ALL 
PAGES from the drop-down menu or typing the page numbers in the text box.

4  Go to the ROUTING TRANSACTION DESCRIPTION section, type the name of the original sender 
in the NAME text box, the original sender’s company name in the COMPANY text box, and your 
comments about the fax in the COMMENTS text box.

5  Click ROUTE. The Omtool server prepares and sends the fax to the destination(s) you specified.

Re-routing multiple faxes
Use the following procedure to re-route multiple faxes.

To re-route multiple faxes:

1  Select two or more faxes in the Processed Items list.

- To select multiple faxes: Select a fax, press and hold the CTRL key, and then continue 
selected faxes.

- To select a group of faxes: Select the first fax in the group, press and hold the SHIFT key, and 
then select the last fax in the group.
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2  Right-click the selected faxes and select ROUTE

.
3  Select a destination from the list on the left and click ADD RECIPIENT, or type a destination in the 

TYPE DESTINATION OR SELECT FROM LIST text box and click ADD.

Note: You can route faxes to multiple destinations in this step. To route faxes to multiple destinations, 
repeat this step until you have added all the destinations to which you want the Omtool server to deliver 
the faxes.

4  Go to the ROUTING TRANSACTION DESCRIPTION section, type the name of the original sender 
in the NAME text box, the original sender’s company name in the COMPANY text box, and your 
comments about the fax in the COMMENTS text box.

5  Click ROUTE. The Omtool server prepares and sends the combined faxes to the destination(s) you 
specified.

Reassigning faxes
When you receive a new fax in FaxCenter that should be re-directed to another FaxCenter user, you can reassign 
the fax.

For example, suppose you are routing faxes for the sales division. A new fax arrives in FaxCenter that should be 
processed by the marketing department. You can reassign this fax to the FaxCenter user in the marketing department 
so that he or she can route the fax to the appropriate destination.

To reassign a fax:

1  Select one or more faxes in the NEW ITEMS list.

2  Click EDIT on the menu bar, and select REASSIGN FAX.

3  Select a FaxCenter user in the Reassign Fax window.

4  Click ASSIGN. The Omtool server reassigns the selected fax(s) to the specified FaxCenter user, 
and removes them from the New Items list.

Using automated routing features
FaxCenter has two automated features:

• Auto Route - You can configure FaxCenter to route all new faxes automatically to a specified 
destination.

• After Hours - You can configure FaxCenter to process all new faxes when no FaxCenter users are 
available to do so.
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Using After Hours
When there are no FaxCenter users available to process inbound faxes, you can enable After Hours. After you enable 
After Hours, the Omtool server begins processing inbound faxes according to the After Hours rules your 
organization uses.

Examples of After Hours processing
Your organization creates a special set of rules for After Hours processing, and these rules might include one or 
more of the following actions:

• The Omtool server routes inbound faxes to a printer so that a designated person can review and 
distribute them.

• The Omtool server routes inbound faxes to the e-mail account of someone in your organization 
who can review and distribute them.

Ask your network administrator how the Omtool server processes inbound faxes After Hours.

Enabling After Hours
You, another FaxCenter user, or an administrator must enable After Hours.

After you enable After Hours, you can log out of FaxCenter and shut down your computer, while the Omtool server 
processes inbound faxes according to the After Hours rules your organization uses.

To enable After Hours:

• Click TOOLS on the menu bar, and select AFTER HOURS. (When After Hours is enabled, a check 
mark appears next to the After Hours option in the Tools menu.)

Disabling After Hours
After a FaxCenter user enables After Hours on the Omtool server, you will not receive new faxes until you or 
another FaxCenter user disables After Hours from their computer. When someone disables After Hours, the 
Omtool server stops processing inbound faxes according to the After Hours rules and delivers inbound faxes to 
FaxCenter users.
© 2006 by Omtool, Ltd. All rights reserved. Omtool, AccuRoute and the Company logo are trademarks of the Company. Trade names and trademarks of other companies appearing in this document are the property of their respective owners.



FaxCenter User Guide

Chapter 3: Working with faxes

54
To disable After Hours:

• Click TOOLS on the menu bar, and clear AFTER HOURS. (When you disable After Hours, the 
check mark next to the After Hours option disappears.)

Using Auto Route
FaxCenter can route all new faxes to a specified destination automatically. When you enable Auto Route, you do not 
need to monitor FaxCenter continuously for new faxes—routing is automatic.

After you enable Auto Route, FaxCenter routes all new inbound faxes automatically to the destinations you specify, 
and moves these faxes to the Processed items list. The Automatic Routing fax box remains on top of other FaxCenter 
windows while Auto Route is enabled. You must disable Auto Route before you can perform other tasks in 
FaxCenter.

You can disable Auto Route and close the fax box at any time. After you disable Auto Route, you can route faxes 
manually.

Enabling Auto Route
Use the following procedure to enable Auto Route.

To enable Auto Route:

1  Click TOOLS on the menu bar, and select AUTO ROUTE. The AUTOMATICALLY ROUTE NEW 
ITEMS dialog box appears.
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2  Select a destination from the list on the left and click ADD RECIPIENT, or type a destination in the 
TYPE DESTINATION OR SELECT FROM LIST text box and click ADD.

Note: You can route faxes to multiple destinations in this step. To route faxes to multiple destinations, 
repeat this step until you have added all the destinations to which you want the Omtool server to deliver 
the faxes.

3  Click ENABLE. The AUTOMATIC ROUTING dialog box appears.

The dialog box remains visible while Auto Route is enabled.

Disabling Auto Route
Use the following procedure to disable Auto Route.

To disable Auto Route:

• Click CANCEL on the Automatic Routing message box.

Releasing faxes
You can release an outbound fax in Registration Pending when the intended recipient of the fax registers with your 
organization as a secure destination.

Understanding secure delivery
When someone in your organization sends a fax and requests secure delivery, the Omtool server holds the fax in 
Registration Pending and sends a notification fax to the intended recipient that instructions the recipient to register 
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with your organization as a secure destination. After the intended recipient registers with your organization as a 
secure destination, the Omtool server releases the fax and delivers future faxes to the same recipient.

Important! Some industries, such as health care, have regulations for delivery to secure destinations. You 
should handle sensitive faxes with caution, as there can be legal ramifications if they are mishandled.

Releasing outgoing faxes
When the intended recipient signs and returns the notification fax, the Omtool server recognizes the incoming fax 
as a notification fax, and releases the outgoing fax to the secure destination. In some cases, the Omtool server is 
unable to recognize the incoming registration fax and might route the fax to FaxCenter instead. As you process faxes 
in FaxCenter, you might recognize a new fax as a notification fax that the intended recipient has signed and returned. 
If you are authorized to release faxes to secure destinations, you can release the outgoing fax that corresponds to 
the notification fax.

Understanding Registration Pending items
A Registration Pending item is an outbound fax that the Omtool server holds until the fax recipient registers with 
your organization as a secure destination. The faxes in the Registration Pending list appear to all FaxCenter users 
who are authorized to release faxes.

Secure delivery
When someone in your organization sends a fax and requests secure delivery, the Omtool server holds the fax in 
Registration Pending and sends a notification fax to the intended recipient that instructs the recipient to register with 
your organization as a secure destination. After the intended recipient registers with your organization as a secure 
destination, the server releases the fax and delivers future faxes to the same recipient automatically.

Recipient registration
To register with your organization, the intended recipient must sign the notification fax and return it to the fax 
number specified in the notification fax. Until the intended recipient returns the notification fax and indicates that the 
destination is secure, the Omtool server holds the original fax in Registration Pending.
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To release a fax to a secure destination:

1  Click VIEW on the menu bar, and select REGISTRATION PENDING. The Registration pending list 
appears in the list pane.

2  Select the fax you want to release to a secure destination.

3  Right-click on the fax and select RELEASE FAX. The Omtool server will attempt to deliver the fax. 
When delivery is complete, FaxCenter removes the released fax from the Registration Pending list.

Finding faxes
Using Find a Fax, you can search FaxCenter and find all the faxes that meet the criteria you specify. You can search 
faxes using the following criteria:

• FAXCENTER USER - If you have permissions to view the faxes assigned to other FaxCenter users, 
you can search for faxes that are in another user’s instance of FaxCenter.

• CURRENT FAX STATUS - you can search faxes that have been routed to a routing recipient or 
Document Management System, or faxes in the New Items list.
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• JOB ID - You can search for a fax by its Job ID number.

• FAX RECEIVED DATE - You can search faxes by the date you received them in FaxCenter. You can 
search for faxes that arrived after a specified date, or before a specified date.

• SENDER’S CSI - you can search faxes by the original senders CSI.

After you start your search, the Found Items list appears in the fax list pane and displays the faxes that match your 
search criteria. Faxes in the Found Items list function as they would in their respective lists:

• New items appearing in the Found Items list - If a fax in the Found Items list is a new fax, you 
can route it, delete it, and view the properties of the fax.

• Processed items appearing in the Found Items list - If a fax in the Found Items list is a 
processed fax, you can re-route it, delete it, and view the properties of the fax.

Furthermore, you can work with faxes just as you can in other fax lists. For example, if you have permissions to do 
so, you can select and route multiple faxes.

If a found fax is a new fax, therefore, you can route it, and then FaxCenter moves it to the Processed Items list. Also, 
if you delete a fax, it cannot be recovered.

Tip: You can use Find a Fax to run a custom report on faxes in FaxCenter. After you search the faxes in 
FaxCenter, you can view, save, and print a report on the faxes in the list.

To find a fax:

1  Click EDIT on the menu bar, and select FIND A FAX. The Find a Fax window appears.

2  Select FAXCENTER USER if you want to locate faxes that have been assigned to a particular 
FaxCenter user, and then type the e-mail address of that FaxCenter user in the text box.

3  Go so the second section, and do one of the following:

- Select NEW ITEMS if you want the report to contain only new faxes that have not been routed 
to their final destinations.

- Select ROUTED if you want the report to contain only faxes that have been routed to their final 
destinations. If you want the report to contain faxes that were routed to a particular e-mail 
recipient, distribution list, printer, or fax machine, select ROUTED TO and type the address of 
the routing destination in the text box. If you want the report to contain faxes that were routed 
to a DMS, select SAVED TO DMS.
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- Select JOB ID if you want the report to contain information about a particular fax and then type 
the Job ID number in the text box.

4  Go to the third section, and do one of the following:

- Select RECEIVED AFTER if you want the report to contain information about faxes that arrived in 
FaxCenter after a particular time, and then specify the date and time.

- Select RECEIVED BEFORE if you want the report to contain information about faxes that arrived 
in FaxCenter before a particular time, and then specify the date and time.

Tip: To select a date, click the drop-down button, click the left and right arrows to select the month, and 
click the date you want to use. To select a time, click on the section you want to change, and click the spin 
box to select a new value.

5  Go to the fourth section and select SENDER’S CSI if you want the report to contain information 
about faxes from a particular sender, and then type the fax number of the sender in the text box.

6  Click FIND. The faxes that match your criteria appear in the Found Items list.

Note: All criteria is optional; however, you must provide at least one criterion for the query.

Checking the status of processed faxes
The Omtool server records information about faxes in each stage of processing. This information, which you can 
view, includes the current delivery status of a fax.

You can check the status of a processed fax by:

• Viewing the journal for the fax - You can view the properties of any fax in FaxCenter. The 
properties of a fax include general properties, information about attachments, and the journal of the 
fax on the Omtool server.

• Running a report on the fax - When you view or print a report on a fax, the report includes the 
history of the fax on the Omtool server and the current delivery status of the fax.

To check the status of a processed fax:

1  Select a fax in a list.

2  Click VIEW on the menu bar, and select PROPERTIES.

3  Click the JOURNAL tab.
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4  Double-click on an entry to view a detailed description of the event.

5  Click the RIGHT ARROW or the LEFT ARROW to view additional entries in the journal.
© 2006 by Omtool, Ltd. All rights reserved. Omtool, AccuRoute and the Company logo are trademarks of the Company. Trade names and trademarks of other companies appearing in this document are the property of their respective owners.



61FaxCenter User Guide

Chapter 4: FaxCenter and DMS applications
CHAPTER 4: FAXCENTER AND DMS 
APPLICATIONS
This chapter includes the following sections:

• Configuring FaxCenter to work with your DMS

• Routing faxes to DMS applications

• Using FaxCenter with FileShare or MyFolder

Configuring FaxCenter to work with your DMS
FaxCenter can work with supported Document Management System (DMS) applications. See http://
www.omtool.com/documentation/dmslibraries/v21/DMSLib21_ConfigurationGuide.pdf for a list of supported DMS 
applications.

To configure FaxCenter to work with your DMS:

1  Click TOOLS on the menu bar, and select Configure DMS. The Document Management 
Configuration window appears.

2  Select the DMS you wish to configure and click CONFIGURE.

3  Configure the DMS logon credentials. The screens that appear differ according to the DMS 
application your organization uses.

4  Click OK when you have finished configuring your logon credentials.

Routing faxes to DMS applications
Use the following procedure to route a fax to your organization’s DMS application.
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To route a fax to a DMS:

1  Select the fax in a list.

2  Click FILE on the menu bar, and select ROUTE TO [NAME OF DMS]. The Login screen appears.

3  Log in to the DMS using the protocol required by the system.

4  Enter the appropriate information to save the fax as a TIF file in the DMS, and then save the 
document.

Note: These steps vary depending on the DMS application your organization uses. Refer to the 
documentation for the DMS for more information.

Using FaxCenter with FileShare or MyFolder
FileShare and MyFolder are exclusive features of the Omtool DMS Libraries. They are shared folders in the local area 
network that function as a common document repositories. You can configure any FaxCenter workstation to route 
documents to the FileShare or MyFolder folders using the login credentials associated with current Windows user 
or the login credentials associated with a particular Windows user.

To route a fax to FileShare or MyFolder:
1  Select the fax in a list.

2  Click FILE on the menu bar, and select Route To [name of DMS]. The FileShare or MyFolder screen 
appears.

3  In the OBJECT NAME text box, enter the file name you wish to assign to your document.

4  From the MULTIPLE USE OPTIONS drop-down list, select one of the following:
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- CREATE NEW DOCUMENT. Selecting this option creates a new document in FileShare. If you 
select this option and the file name already exists, the following message appears. Click YES to 
replace the file or click NO to return to the FileShare screen.

- OVERWRITE ORIGINAL DOCUMENT. If a document already exists with the file name you 
selected in Step 4, selecting this option overwrites the original file. Click YES when the following 
message appears to replace the file or click NO to return to the FileShare screen.

5  Click SAVE.
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CHAPTER 5: SETTING UP ALERTS
This chapter includes the following sections:

• Using alerts

• Configuring alerts

FaxCenter allows you to configure an alert when a new message arrives. Alerts help speed fax routing, by alerting 
the FaxCenter user to new items that need processing.

Using alerts
Using FaxCenter options, you can set up alerts that indicate when new faxes arrive in FaxCenter. FaxCenter can alert 
you to new faxes by:

• Making an alert sound. You can select any WAV file on your system.

• Flashing the FaxCenter icon on the task bar. This option is enabled by default.

• Displaying the new fax icon in the task tray. This option is enabled by default.

You can use any combination of alerts for new faxes.

Configuring alerts
Use the following procedure to configure alerts for new faxes.

To configure alerts:

1  Click TOOLS on the menu bar, and select OPTIONS. The Options screen appears.
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2  Go to the FIRST NOTIFICATION section. To enable the first notification, select WHEN A FAX IS 
UNPROCESSED FOR [...] MINUTES and click CONFIGURE. The RECEIVED FAX OPTIONS dialog 
box appears.

3  Select the alerts that should be part of the first notification:

- Select PLAY A .WAV FILE if you want FaxCenter to play an audio file as part of this notification, 
click BROWSE, navigate to the audio file, select it, and click OPEN.

- Select DISPLAY THE FAXCENTER WINDOW if you want FaxCenter to display the FaxCenter 
window on top of all other windows as part of this notification.

- Select FLASH THE NEW FAX TASKTRAY ICON if you want FaxCenter to flash a special icon in 
the task tray as part of this notification. Then, select the length of time this notification should 
last. Select SECONDS OR MINUTES in the drop-down menu, and select a number in the spin 
box.

4  Click OK.

5  Locate the spin box that allows you to select the number of minutes for the first notification. The 
length of time represents the number of minutes a new fax resides in FaxCenter for FaxCenter 
notifies you about the new fax.

6  Repeat these steps to configure a second and third notification, if desired.

7  Click OK.
© 2006 by Omtool, Ltd. All rights reserved. Omtool, AccuRoute and the Company logo are trademarks of the Company. Trade names and trademarks of other companies appearing in this document are the property of their respective owners.



67FaxCenter User Guide

Chapter 6: Generating reports
CHAPTER 6: GENERATING REPORTS
This chapter includes the following sections:

• Creating reports

• Generating reports

FaxCenter has the capability of printing reports on one or more faxes.

When you create a report, it appears in your default browser. Using the print and save options in your browser, you 
can print and save the report.

Creating reports
The following sections describe the type of information the reports can contain.

Summary
• REPORT ON FOLDER - The folder name from which the report was generate.

• SELECTION - The description of the faxes included in the search criteria.

• TOTAL FAXES - Total number of faxes in the report.

• TOTAL PAGES - Total number of pages for all faxes in the report.

• AVERAGE TIME TO ROUTE - The average length of time these faxes waited to be routed.

• MAXIMUM TIME TO ROUTE - The maximum length of time a fax in this report waited to be 
routed.

Fax details
• JOB ID - The Job ID number of the fax.

• RECEIVED DATE/TIME - The date and time the FaxCenter user received the fax.

• ROUTED PAGES - The number of pages in the routed fax.

• RECEIVED PAGES - The number of pages in the received fax.

• ROUTED DATE/TIME - The date and time the fax was routed from FaxCenter to its final 
destination.

• ROUTED BY - The e-mail address of the FaxCenter user who routed the fax.

• TIME IN FAXCENTER - The length of time the fax resided in FaxCenter.

• SENDER INFORMATION - The sender’s name, company, comments, device CSI, and the ANI/Caller 
ID.
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• DESTINATION - The final destination of the fax.

Generating reports
Use the following procedure to generate a report.

To generate a report:

1  Open the list that contains the faxes you want to include in the report.

2  Select one or more faxes in the list.

3  Click FILE on the menu bar, and select REPORT OPTIONS.

4  Select an option:

- ALL ITEMS - Select this option to include all faxes from the list in the report.

- SELECTED ITEMS - Select this option to include only the selected faxes in the report.

5  Select SUMMARY INFORMATION ONLY if you want the report to contain only top-level summary 
information with no specific information about individual faxes.

6  Select SAVE REPORT TO DISK if you want to save the HTML report that contains information 
about faxes in FaxCenter, and then provide the location and name of the report in the text box. 
The complete path to the file should look similar to the following example: C:\Program 
Files\Omtool\FaxCenter\Reports\ProcessedItems0913013.htm

Note: You can specify any location as the destination for the saved report.

7  Click OK to open the report in your default browser.

Tip: When you view the report in your browser, you can save and print the file by using your browser. For 
more information, refer to the help on your browser.
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ANI

ANI (Automatic Number Identification) is a service that you can order from your telephone service provider that 
provides you with the phone number of the calling telephone line. It is also known as caller ID. The method of 
providing this service varies from provider to provider, but typically it is done by forwarding DTMF (Dual-Tone Multi-
Frequency) digits along with the phone call.

CSI (Called Subscriber Identification) 

A text field returned by the receiving fax machine to the originator and usually containing the recipients fax number 
(as programmed into their fax machine). It may be possible to instruct a sending fax server to check the CSI from 
the remote machine is correct before sending a fax. 

DID (Direct Inward Dialing) 

The capability to dial directly a specific internal number or extension in a company, without going through an 
operator. A DID number may relate to a physical extension with a telephone of fax machine, or to a “logical” 
extension identifying a specific fax recipient. DID Trunks DID trunks are employed to reduce the number of channels 
between the PBX and the telephone company central office. A PBX or fax modem bank receives a call over one of 
the channels in a DID trunk, and can interpret three- or four-digit extension number information passed to it over 
the trunk. 

DTMF (Dual-Tone Multi-Frequency) 

Push-button or Touch-tone dialing. In DTMF, when a button is pushed, it makes a sound that is a combination of two 
tones, one high frequency and one low frequency; hence, the name dual-tone multi-frequency. DTMF tones, entered 
after a connection is made and the receiving fax device has answered the phone, are often used for specialist inbound 
fax routing applications.

Job ID

As it processes faxes, the Omtool server assigns a Job ID number automatically to each fax. Your network 
administrator can use the Job ID number to identify the fax on the Omtool server if an error occurs.

Omtool server

The Omtool server is the software your organization uses to compose and distribute outbound faxes and route 
inbound faxes to FaxCenter users, e-mail recipients, and fax recipients.

Secure destination

A secure destination is a fax destination where only the intended recipient can view the document.
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TSI (Transmitting Subscriber Information) 

A frame containing text data that may be sent by the caller, typically containing the caller's telephone number (as 
programmed into their fax machine). This data may be used to screen calls or route received faxes. 
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